
    Account

Enter supplemental logon information required for access to resources once a logon to an FTP server has 
been completed. This is seldom required by current FTP servers.



    All Entries

Request that the FTP server include all entries (including dot files) when performing directory listings.    
This option is usually only useful when the server is a UNIX system.

This option is off by default.



    Anonymous Login

Logon to an FTP server with the username anonymous.

Most servers that accept anonymous logons request that you supply your e-mail address as the 
password. When the Anonymous Login option is selected for a Quick Connect, or when creating a new 
session database entry, AbsoluteFTP automatically selects anonymous as the username and fills in the 
password field using the password you supplied in your Global     Options  .



    Arrange Icons

Sort the items in a folder by Name, Size, Type or Date.

You can choose to enable the Auto Arrange option. With this option enabled the icons in your session 
window will automatically adjust their rows and columns as you resize the window. the Auto Arrange 
option is only available if the icon view has been set to Large Icons or Small Icons.



    Change Directory (Go To)

Prompts for a directory that becomes the current directory for the selected session.    The current directory 
is displayed in the title bar of each session.



    Close

Closes the connection to the FTP server for the current session and closes the session window.



    Command-Line Usage (GUI only)

You can start AbsoluteFTP and specify further options and arguments from the command line.    
Command-line instructions must have the following syntax:

AbsoluteFTP [Option] Host

The table below lists the options recognized by AbsoluteFTP with their applicable arguments.

Option Argument Description

/Log path/filename Turns on logging for the AbsoluteFTP session 
and writes to the specified file.

The table below lists the hosts recognized by AbsoluteFTP with their applicable arguments.    A host can 
be either a file or folder.

Host Argument Description

URL Opens the program to the specified URL.    FTP 
URLs must be in the following format:

ftp://[<user>[:<password>]@]<host 
address>[:<port>][<path>]

Hostname Opens the program to the specified host or IP 
address

/S session path Opens the program to a specific session. 

The session path must be the full path of a 
session profile in the database as in the 
following example:

"/Software/Commercial 
Software/VanDyke Software"

If the pathname contains spaces, enclose it in 
quotation marks.

Examples

Connecting to named sessions:

AbsoluteFTP.exe /S /ftp.vandyke.com

Tip:    Use quotation marks on the command line if the path contains spaces:

AbsoluteFTP.exe /S "/Software/Commercial Software/VanDyke Software"

Connecting to host addresses:



AbsoluteFTP.exe ftp.vandyke.com

or

AbsoluteFTP.exe 192.168.0.1

Connecting to URLs:

AbsoluteFTP.exe <FTP URL>

where the FTP URL is of the following form:

ftp://[<user>[:<password>]@]<host address>[:<port>][<path>]

For example:

ftp://bob:r2d2c3po@vandyke.com:22/Documents/Spreadsheets/

Logging all transfer activity for a given week to the same file (where %week% is an environment variable 
set by another tool) 

AbsoluteFTP.exe /Log c:\Weekly Logs\%week%.log ftp://host/pub/*.log c:
\June1to7

Logging all transfer activity for a given command-line QuickSync target (where Target is an environment 
variable set in your batch file).

Set Target=Corporate
AbsoluteFTP.exe /Log "c:\Transfer Logs\%Target%.log" /QuickSync C:\
%Target%Data\*.* /%Target% C:\Data Mirror
Set Target=Sales
AbsoluteFTP.exe /Log "c:\Transfer Logs\%Target%.log" /QuickSync C:\
%Target%Data\*.* /%Target% C:\Data Upload

See also:

Command-Line Utility



    Connect

The Connect dialog allows you to manipulate your session database and make connections to FTP sites.

The session database is organized into folders and sessions that are displayed in the tree view in the 
center of the dialog.    Folders are used to group sessions into logical categories.    Sessions contain the 
data needed to connect to an FTP site.

The following commands allow you to manipulate the session database.    These commands can be 
accessed from the toolbar or context menus.    The context menus are activated by clicking the right 
mouse button in the tree view.

Commands

Connect:    Causes AbsoluteFTP to connect to the FTP server named in the selected session.

Quick Connect:    Causes AbsoluteFTP to open the Quick Connect dialog.

New Session:    This command brings up the New Session wizard or the Session Options dialog where 
all of the information needed to create a new session can be entered.    The new session is created under 
the currently selected folder.

Properties:    This command brings up the Session Options dialog where the information for the 
selected session can be edited. 

New Folder:    This command causes a new folder to be added under the currently selected folder.    The 
folder is named "New Folder" and can be edited in place.

Cut:    This command causes the selected folder or session to be placed on the Clipboard and marked to 
be moved.    The item is not moved until a paste is performed.    This command can also be accessed 
using the CTRL+X keyboard accelerator.

Copy:    This command causes the selected folder or session to be placed on the Clipboard.    This 
command can also be accessed using the CTRL+C keyboard accelerator.

Paste:    This command causes the folder or session that is currently on the Clipboard to be placed under 
the currently selected folder.    If the paste was proceeded by a cut, the item is moved to the selected 
folder.    This command can also be accessed using the CTRL+V keyboard accelerator.

Delete:    This command causes the selected folder or session to be deleted from the session database.    
A confirmation dialog is displayed before the deletion is performed.    This command can also be accessed 
using the DELETE key.

Rename:    This command allows the selected folder or session name to be edited in place. Renaming 
can also be done by doing a slow double-click on the name.

Import:    This command is used to import session information from other FTP clients into the 
AbsoluteFTP session database.    See the Import topic for details on importing other databases.

Create Desktop Shortcut:  This command is used to create a desktop shortcut for the selected session. 
See the Create Desktop Shortcut topic for details on creating a shortcut.

Show descriptions:    When this option is checked, the session host address and description are shown 



in a tool tip when the mouse pointer is moved over the session name.    Unchecking the check box turns 
off the tool tips.    This feature is enabled by default.

Show dialog on startup:    When this option is checked,    the Connect dialog is displayed when you start 
AbsoluteFTP.    Unchecking the check box turns off this feature.    This feature is enabled by default.

Toolbar

The following toolbar buttons allow access to some of the above commands.

Icon Command

Connect

Quick Connect

New Session

Properties

Cut

Copy

Paste

Delete

New Folder

Import

Create Desktop Shortcut

Help

Keyboard Accelerators

The following keyboard accelerators can be used to access the Connect dialog commands

Command Accelerator
Connect ALT+C
Quick Connect ALT+Q
New Session ALT+N
Properties ALT+ENTER
Cut CTRL+X
Copy CTRL+C
Paste CTRL+V
Delete DEL
New Folder ALT+F
mport ALT+I
Shortcut ALT+S
Rename ALT+M or F2
I



Session Database Tree View

If a folder contains sub folders or sessions, a (+) shows to the left of the folder icon.    Clicking the 
Plus Sign (+) or double-clicking the folder will expand to show the subfolders.

Click the Minus Sign (-) next to an expanded folder, or double-click the folder icon to collapse the 
expanded subfolders.

Double-clicking on a session name will cause AbsoluteFTP to connect to that session.

Folders and sessions can be copied or moved    in the tree view using standard drag-and-drop 
operations.    The one exception to this is the root folder "FTP Sites" which cannot be moved or deleted.

Folders and sessions can be cut, copied, and pasted using the standard CTRL+X, CTRL+C, and 
CTRL+V keyboard accelerators, respectively.

Folders can be automatically arranged in alphabetical order or manually arranged as desired.

Tips

The New Session toolbar button and context menu item can be configured to open the Session Options 
dialog directly rather than the New Session Wizard.    Change this option in the Global Options dialog on 
the Options / Advanced    page.



    Connecting to a Remote FTP Server

There are two methods for connecting to an FTP server:

Method 1: set up a temporary connection using Quick Connect.

Choose the 'Quick Connect...' item from the File menu.

Enter the server address (e.g. ftp.microsoft.com or 198.105.232.1) in the 'Hostname' field.

If the Anonymous login check box is checked, you will need to enter your e-mail address as the 
password in the 'Password' field.    This gives you permissions on some servers to download public 
domain files, but you will probably not be able to upload files to the FTP server.

Another option here is to uncheck the Anonymous login check box, and enter a valid account name (or 
logon ID) for the server to which you are connecting in the 'User name' field.    You will need to enter the 
password for the account in the 'Password' field.

Click the 'OK' button.

Method 2: set up a permanent, reusable entry in the session database.

Choose 'Connect' from the File menu to bring up the "Connect" window.

Click the 'New Session' toolbar button.

Enter the FTP server's address (e.g. ftp.microsoft.com or 198.105.232.1).

Click the 'Next' button.

If the Anonymous login check box is checked, you will need to enter your e-mail address as the 
password in the 'Password' field.    This gives you permissions on some servers to download        public 
domain files, but you will probably not be able to upload files to the FTP server.

Another option here is to uncheck the Anonymous login check box, and enter a valid account name (or 
logon ID) for the server to which you are connecting in the 'User name' field.    You will need to enter the 
password for the account in the 'Password' field.

Click the 'Next' button.

Click the 'Next' button to bypass the initial directory page.

Click the 'Finish' button to accept the default session name.

Select the new entry just created.    Note that this entry is saved in the AbsoluteFTP database and 
can be reused by bringing up the "Connect" window (see step 1).



Click the 'Connect' button.

After you initiate a connection using one of the above methods, a session window should open and list 
the files for the account used.



    Copy Path

Copy the path of the selected file or folder to the Clipboard.



Create a copy of the selected session.



    Copy URL

Copy the URL of the selected file or folder to the Clipboard.



    Copy and Paste

Copy selected files and folders from one folder to another using the keyboard.

Files and folders may be copied between folders within the local machine window, between a folder in a 
remote session window and a folder in the local window, as well as between two remote session 
windows.    When a remote session window is part of a Copy/Paste operation, the Paste initiates the file 
transfer.

1. In a local folder or remote session window folder, click on the file or folder to be copied.
2. Select Copy from the Edit menu
3. Open the folder where you want to put the copy.
4. Select Paste from the Edit menu.

Note, AbsoluteFTP does not support copy/paste of files with other applications.

Tips

To select more than one file or folder to copy, hold down the CTRL key, and click each of the 
items.

The Copy and Paste commands are also available in the right mouse button menu.

 This toolbar button invokes the Copy command.

 This toolbar button invokes the Paste command.



    Customize Toolbar

Customizing the toolbar allows you to arrange the main toolbar to suit your needs and preferences.    The 
majority of those functions contained in the AbsoluteFTP menus have an associated toolbar button for 
your use. 

There are two methods available for customizing the toolbar.

Customize Toolbar Dialog:    The Customize Toolbar dialog is accessible using any of the 
following methods.

1. Select "Customize Toolbar" from the "Tools" menu on the main menu.
2. Right-click on the toolbar and select "Customize Toolbar" from the resulting context menu.
3. Double-click on the toolbar in any area not occupied by a button. 

ALT+drag:    To use the ALT+drag method, place the mouse pointer over a toolbar button.    Then 
simultaneously hold down the ALT key and the right mouse button.    While still holding down the ALT key 
and mouse button, you can drag the button to a new location.

Functions

The following functions allow you to manipulate the toolbar.

Rearrange buttons:    To rearrange the buttons using the ALT+drag method, drag the button to the 
desired location and drop it there.    To rearrange the buttons using the Customize Toolbar dialog, select 
the button to move in the "Current toolbar buttons" list.    Then press either the "Move Up" or "Move Down" 
buttons until the button is in the desired position.    Separators can only be moved using the Customize 
Toolbar dialog.

Remove a button:    To remove a button using the ALT+drag method, drag the button off the toolbar and 
drop it.    To remove a button using the Customize Toolbar dialog, select the button in the "Current 
toolbar buttons" list and click on the "Remove" button.    The button will be moved to the "Available toolbar 
buttons" list and removed from the toolbar.    Separators can only be removed using the Customize 
Toolbar dialog.

Add a button:    Adding a button or separator can only be done using the Customize Toolbar dialog.    
First determine where in the toolbar that you want to insert the new button or separator.    The new button 
will be inserted above the button that you select in the "Current toolbar buttons" list, so select the 
appropriate button or separator in the "Current toolbar buttons" list.    Now select the button that you want 
to add in the "Available toolbar buttons" list and click the "Add" button.    The button will be added to the 
"Current toolbar buttons" list and to the toolbar.    You can adjust the position of the button using the "Move 
Up" and "Move down" buttons.

Reset default toolbar:    To reset the toolbar to its default configuration, open the Customize Toolbar 
dialog and click the "Reset" button.

Note:    If you remove all of the non-separator buttons from the toolbar and exit AbsoluteFTP, the 
default toolbar will be displayed.



    Delete

Deletes the currently selected files or folders.

Tip

 This toolbar button invokes the Delete command.



Prompts for the name of the session folder to be deleted. Any sessions or sub folders below it will also be 
deleted.



Delete the selected session from the session database.



    Create Desktop Shortcut

Perform the following steps to create a desktop shortcut that, when double-clicked, will start AbsoluteFTP 
and immediately connect to the associated session.

1. Select a session in the Connect dialog.
2. Click the Create Desktop Shortcut toolbar button or select the Create Desktop Shortcut command 

on the session context menu.
3. Enter the shortcut label in the resulting dialog.
4. Click OK.

Note:    Because only one instance of AbsoluteFTP can be running at one time, double-clicking on an 
AbsoluteFTP shortcut when AbsoluteFTP is already running will have no effect.



    Disconnect

Closes the connection to the FTP server in the current session.

A disconnected session window remains open. The connection to the server can be reestablished with 
the Reconnect menu item. Actions like Refresh, opening a directory, or transferring a file will also cause a 
disconnected session to reconnect.

Tip

 This toolbar button invokes the Disconnect command.



    Download

Download the selected files and directories.    This command will initiate a transfer from the FTP server to 
the local directory specified in the default     download     directory   field of the Session     Options  .    If the 
download directory for the session is blank, then the default     download     directory   setting under the 
Global     Options   will be used.    If both download directory settings are blank, you will be prompted for the 
local directory.



    Drag-and-Drop

Copy selected files and folders from one folder to another using the mouse.

1. Click the icon of a file or folder to be copied and hold the mouse button down (normally the left 
button)

2. Drag the file icon to the destination folder and release the mouse button.

Files and folders can be dragged and dropped (i.e. copied) between folders within the local machine 
window, between a folder in a remote session window and a folder in the local window, as well as 
between the folders of two remote session windows.    Dragging and dropping within a remote session 
window, however, is not currently supported. If a remote session window is either the target or source of 
drag/drop operation, then dropping the file initiates the file transfer.

Note:  AbsoluteFTP does not currently support drag-and-drop of files with other applications.

Tip

To select more than one file or folder to drag, hold down the CTRL key, and then click the items 
you want to copy. Then drag the selected items as described above.



Renames the selected folder.



    Exit

Close all connections and exit the program.



    File Creation Mask (UMASK)

The file creation mask is a value that is used to determine the default permissions settings for new files. 
This feature is usually only available on UNIX systems.

The value specified for the file creation mask is given in octal and is XORed on the remote system with 
the permissions of 666 for files and 777 for directories.    For example, the value 002 would give complete 
access to the group and only read (and directory search) access to others.    The value 022 would give 
only read (and directory search) access to the group and others.



    Global Options, Options / Advanced

The following options control advanced features in AbsoluteFTP.

Options

New Session uses wizard - Enabling this option causes the New Session toolbar button in the 
Connect dialog to start the New Session Wizard.    Disabling this option causes this button to open the 
Session Options     dialog instead. This option is enabled by default.

Log messages during transfer - Enabling this option causes extra information about file 
transfers to be sent to the log window. This option is disabled by default.

Move deleted local files to the Recycle Bin - This option is enabled by default. Disabling this 
option causes deleted local files to be deleted from the file system.

Keep connections alive - This option is off by default.    Enabling this option causes 
AbsoluteFTP to send FTP NO-OP commands to the FTP server whenever 1 minute or more has passed 
without sending a normal file operation command.    This will usually keep the FTP server from detecting 
that the connection is idle and, consequently, disconnecting the session.

It is not recommended that you leave this feature enabled.

Log

Enable log output to file - Enabling this options causes the AbsoluteFTP output to be logged to 
the specified file.

Log filename - This is the log file's full path.

Permissions
This group contains options that allow you to specify file and directory permissions.    The permissions 
should be specified in the appropriate octal representation.    For FTP connections, these options only 
work with UNIX systems.

File permissions - This option allows you to specify the read/write/execute permissions on 
uploaded files.    For example, entering 660 in the entry box gives read and write access permissions to 
the file owner and the group.    If this option is left blank/empty, no attempt will be made to set the 
permissions and the permissions used on the files will be set according to the user's UMASK settings on 
the remote system. 

This option only affects new files that are uploaded (i.e., it will not change the permissions on files that 
already exist).    The exception to this rule is that when the Always overwrite option is chosen for existing 
files, the permissions will be overwritten even for existing files.

Directory permissions - This option allows you to specify the read/write/execute permissions on 
created directories.    For example, entering 775 in the entry box gives read and write access permissions 
to the directory owner and the group, and read access to the world.    If this option is left blank/empty, no 



attempt will be made to set the permissions and the permissions used on the directories will be set 
according to the user's UMASK settings on the remote system.



    Global Options, File Types

Configure the registered file types and their associated actions for remote sessions.

File types can be registered with AbsoluteFTP so that specific actions are taken when files are opened in 
a remote session. For example, you can configure AbsoluteFTP to automatically download, then open 
remote Text Documents with Notepad when you double-click them in a remote session. The initial file 
types used by AbsoluteFTP are imported from the settings used by Explorer when AbsoluteFTP is 
installed. You may add, edit or remove any of the registered file types.

Note:    The actions and applications for the registered file types described here apply only to files 
opened in remote session windows. Each file type also includes information that applies only when 
opening a remote file, such as transfer type and save-to-disk options. The file types used when 
opening files in AbsoluteFTP local window are the same file types used by Windows Explorer. (Refer 
to File Types in Windows Explorer Help for more information).

New - Click this button to add a file type.    See Editing a file type section below for details on how to add a 
file type.

Delete - Delete the currently selected file type.

Edit - Click this button to edit the currently selected file type.    See Editing a file type section below for 
details on how to edit a file type.

Search - You can search for a file type that is associated with a file extension by entering the file 
extension in the Ext. edit box.    Pressing return in this edit box or clicking the Search button will cause the 
file type that is associated with the entered file extension to be displayed and highlighted in the file types 
list.

Reset All - Click this button to cause all of the file types known by Windows Explorer to be reloaded into 
AbsoluteFTP.

Editing a file type:

Enter the following information when editing or registering a new file type:

1. Choose a Default icon to display for the file (recommended).

2. Enter a short text Description of the file type (required).

3. Choose a transfer type.

4. Open with: choose the program that is used to open this file type (recommended).

5. Remote open: choose the action to be taken when files of the registered type are opened on a 
remote host. There are three choices:

Prompt for open action

Open

Save to disk



6. Associated extensions: Use the Add and Remove buttons to choose filename extensions for 
the file type (recommended).



    Global Options, Firewall

AbsoluteFTP can work with a variety of Internet firewall servers.    If your FTP connections to Internet sites 
require the use of a firewall, select the appropriate type of firewall (described below) from the dropdown 
list.    In addition to specifying a firewall type, you may also create a list of domains whose connections are 
excluded from connecting through the firewall.

Type

None - Choose this option if you are connected directly to the Internet without a firewall.    You 
may also need to choose this option if you are behind a router-based firewall, which is normally 
transparent to the user.    If you are behind a router-based firewall, you may need to enable passive data 
connections in the session options.

SOCKS Version 4,

SOCKS Version 5 (no authentication)

SOCKS Version 5 (username/password) - If your firewall server is running either SOCKS 
version 4 or SOCKS" version 5, select one of these types for the Type field.    Enter the hostname or IP 
address of your SOCKS firewall server in the "Hostname or IP" field, and enter the SOCKS firewall port 
number in the "Port" field.    The conventional port number for SOCKS is 1080.

The username/password version of the SOCKS firewall choices allows for firewall user authentication.    
The only method of authentication currently supported is the "Username/Password Authentication" 
protocol, which requires the username and password to be sent as clear text.    Therefore, this method is 
not recommended for non-secure environments

OPEN host - Select this type if your firewall server requires the OPEN command.    This type may 
be selected for the CSM proxy server.    Also, enter the hostname and port of the firewall server in the 
appropriate fields.

USER user@host:port - Select this type if your server is running the WinGate proxy server.    
Enter the hostname or IP address and port of the firewall server in the appropriate fields.    This type may 
also be selected for use with the CSM proxy server.

This type should also be used for the WinProxy proxy server.    For this particular proxy server you may 
also need to have the Use outgoing data connections (PASV) option unchecked on the Session 
Options dialog, Options / FTP page.

USER user@host port,

USER user@host port (with login) - Select these types if your server is running the TIS® 
Internet Firewall Toolkit.    Choose the first form if the firewall server does not require authentication.    If 
your firewall server requires authentication, choose the second form.    Also, enter the hostname or IP 
address and port of the firewall server in the appropriate fields.

USER user@host login - This type will send the remote username and the server address 
followed by the firewall user ID.    It then expects to send the password for the remote user and the 
password for the firewall user.    This type should be used if your server is running the Raptor Firewall.
For this firewall type you will need to enter the username and password that is required by the firewall 



server to authenticate your connection.    Also, enter the hostname or IP address and port of the firewall 
server in the appropriate fields.

Parameters

Hostname or IP - Enter the hostname or IP address of the firewall.

Port - Enter the port number for the firewall.

Username - Enter your username.    This parameter is only available under the SOCKS 5 
(username/password), USER user@host (with login), and USER user@host login types.    If left blank, 
you will be prompted to enter the proxy username when connecting.

Password - Enter your password.    This parameter is only available under the SOCKS 5 
(username/password), USER user@host (with login), and USER user@host login types.    If left blank, 
you will be prompted to enter the proxy password when connecting (if the proxy server requires it).

Domain exclusion

Excludes specific connections from passing through the firewall.

If AbsoluteFTP is configured to use a firewall, it may still be desired to exclude certain connections from 
being made through the firewall.    A typical example of this would be an organization that operates a 
network that is protected from the Internet by a firewall.    Connections to FTP servers within the 
organization's internal network could be made directly and should not pass through the firewall, while 
connections to FTP servers on the Internet must all pass through the firewall.    You can exclude the 
internal FTP servers by adding them to the exclusion list.

Entries in the domain exclusion list may be either hostnames or IP addresses.    A leading or trailing 
asterisk can be used as a wildcard character to select groups of machines.    The following example of a 
leading asterisk would exclude connections to all machines in the domain "yourdomain.com" from 
connecting through the firewall:

*.yourdomain.com

This example of a trailing asterisk prevents connections to all machines within a particular network from 
passing through the firewall:

192.168.0.*

Also, a complete hostname of an FTP server or its IP address can be used to exclude one specific 
machine from using the firewall:

192.168.0.134
ftp.yourdomain.com

Click the Add, Edit and Remove buttons to enter, change and delete entries from the domain exclusion 
list.



    Global Options, View

The following options control the attributes of the local window or of session windows.

General

Display the full path in title bar - Select this option to display the full pathname of the current 
directory in the title bar of both the local window and session windows.    If this option is disabled, only the 
directory name is displayed in the title bar.    This option is disabled by default.

Show file attributes in Details view - Select this option to include an Attributes column in 
windows that use the Details icon view.    In the local window this column will display Windows file 
attributes.    In remote session windows this column displays UNIX-style permissions, owner and group 
ownership of files.    This information is usually only available on UNIX-based FTP servers.

Display the folder tree - Select this option to display the folder tree view.    This default behavior 
can be temporarily superseded with the use of the Folder Tree command on the View menu or with the 
Folder Tree toolbar button.

Local window

Display filenames using Explorer attributes - Enabling this option forces AbsoluteFTP to 
display filenames with the same alphabetic case as the Windows Explorer.    For example, an uppercase 
filename stored on disk as AUTOEXEC.BAT will normally display in Windows Explorer as Autoexec.bat.    
By default, this option is disabled, which causes filenames to be displayed using the same alphabetic 
case in which the name is actually stored on disk.

Note:    When a file is uploaded to a remote site, the real filename case is used regardless of 
this setting.

Do not show hidden or system files - This option affects the local window only and is 
disabled by default.

Remote window

Do not show dot files - Enabling this option prevents filenames beginning with a dot (.) in 
remote directories from displaying.    By default, it is enabled.    This option may    be temporarily 
superseded using the Dot Files command on the View menu.    However, the Do not show dot files 
option will take precedence over the All entries option in the Options/FTP category of the Session 
Options dialog.

Display file times in local time zone - Enabling this option causes the remote directory file 
times to be displayed in the time zone being used by the local machine rather than the time zone defined 
for the session.    This option may be helpful when visually comparing the file times displayed on the 
remote machine to the file times displayed in the local window.    By default, this option is disabled.

Display the log view - Select this option to display the session window's log view.    This default 
behavior can be temporarily superseded    with the use of the Log View toolbar button.



Save session window position - Checking this option instructs AbsoluteFTP to store your 
session window positions when you close the windows and reopen them in the same place.

Log window buffer size (lines) - This option sets the maximum number of lines that each log 
window can display.    The default value is 500.

Transfer window

Number style - This option sets the way that numbers are displayed in the transfer window.    The 
default selection is Abbreviated.    The available options are:

- Abbreviated - Selecting this option will cause numbers to be displayed using an appropriate 
abbreviated size quantity (i.e., KB, MB, GB).    Numbers less than 1 kilobyte are not 
abbreviated.

- Punctuated - Selecting this option will cause numbers to be punctuated using the Regional 
parameters defined in the system settings (e.g., numbers would be displayed with commas 
after every three digits on U.S. systems).



    Dot Files

Displays filenames beginning with a "." in remote directories.    This command lets you temporarily 
override the default behavior set in the Do not show dot files option in the Global Options.    If no dot 
files apppear with this option turned on, you can also view all the files in a folder by checking the All 
entries option in the Options/FTP category of the Session Options dialog.



    Hostname

Most FTP servers have a hostname    that you can use to connect to them, like ftp.microsoft.com, 
ftp.vandyke.com, etc. A valid hostname will also correspond with an IP address. When specifying a host 
address for a session you may enter either a hostname or an IP address.



    IP Address

Every site that is reachable on the Internet must have a valid IP, or Internet Protocol, address.    An IP 
address should be entered as 4 numbers separated by period (.) characters, for example: 198.105.232.1



    Icon View Options

Select the size and layout of the icons shown in the right-hand pane of a window. 

The following choices are available from the View menu:: Large Icons, Small Icons, List, or Details.

Tip

The icon view options may also be selected from the toolbar via the following icons:

Icon View Type

Large icons

Small icons

List

Details



    Import

The session information from other FTP clients can be imported into the AbsoluteFTP session database 
using this feature.

CuteFTP versions 2.0, 2.6 - 3.0, and 4.0

1. Select the folder in the Connect dialog under which you wish to import the CuteFTP database.
2. Click the Import toolbar button or select Import from the folder context menu.
3. In the file selection dialog, select "tree.dat" file    for CuteFTP version 2.0; "smdata.dat" for 

versions 2.6 - 3.0, or "sm.dat" for version 4.0 databases.    If you do not enter one of these three 
file names, you will receive an error and your import will be terminated.

4. Click Open to import the data into the AbsoluteFTP session database.

WS_FTP

1. Select the folder in the Connect dialog under which you wish to import the WS_FTP database.
2. Click the Import toolbar button or select Import from the folder context menu.
3. In the file selection dialog, select "WS_FTP.ini"    file.
4. Click Open to import the data into the AbsoluteFTP session database.

Passwords

For imported sessions that use anonymous FTP logon, the user name "anonymous" is used in the 
imported session and the noe-mail address stored in the imported database is used as the password 
for that session.

For imported sessions that do not use anonymous FTP logon, no attempt has been made to decrypt 
the password that is stored in the database.    To avoid being prompted for a user name and password 
for these types of sessions, the password must be reentered.    This can be done by selecting the 
session in the Connect dialog and then clicking the Properties button in the toolbar.    The password 
field is on the Site page of the Session Options dialog.



    Initial Directory

Specify the initial directory for an FTP session.

If the initial directory has been specified for a session, then that directory will be made the current 
directory upon connection to the remote host.    If the initial directory is not set, the default or home 
directory for the username on the remote system will be the initial directory.



    Invert Selection

Toggle the selected or unselected state of all items in the current folder.



    How to Order Licenses

Upon receipt of payment, we will send you one license key for each copy of AbsoluteFTP paid for.    The 
license key or keys will be sent to you by e-mail or postal mail.    All software and software updates are 
available from www.vandyke.com.    Because the software is obtained by Internet download, no disk 
media will be mailed.

Four payment methods are available.

1. Order online with a credit card.

To order online with a secure web server, go to:

http://www.vandyke.com/purchase/index.html

2. Order by mail with a check.

To order by mail    send the order form (click here) and a check to: 

VanDyke Software, Inc.
4848 Tramway Ridge Dr. NE, Suite 101
Albuquerque, NM    87111
USA

Payments must be in U.S. dollars drawn on a U.S. bank.

3. Ordering by phone with a credit card.

To order by phone, call VanDyke Software between 7:30 a.m. and 5:00 p.m. U.S. Mountain Time, 
Monday through Friday. 

Phone:    505-332-5710

4. Order by fax with a credit card.

Fax the    order form  to VanDyke Software.    Please be sure to fill out the credit card information.

Fax:    505-332-5701

Visa, MasterCard, American Express, and Discover are accepted.    Please include the credit card 
number, cardholder name, expiration date and billing address.

Orders will be processed within one to two business days after they are received by VanDyke Software.

Any questions about the status of the shipment of the order, refunds, registration options, product details, 
technical support, volume discounts, dealer pricing, site licenses, non-credit card orders, etc., must be 
directed to VanDyke Software, 4848 Tramway Ridge Dr. NE, Suite 101, Albuquerque, NM 87111, USA or 
sales@vandyke.com.



    Line up Icons

Line up icons that are out of alignment in a folder.

This option is not available if you have selected List or Details for your Icon View options.



    Log Window

Each session window displays a log of the FTP commands sent to the FTP server and the responses that 
are received. You can adjust the number of visible lines for the log window by dragging the horizontal 
splitter bar of the session window upward or downward.

Adjusting the log window buffer size

By default, the log window holds 500 lines. You can adjust the size of the log window buffer in the 
Global Options dialog.

Copying the log window text to the Clipboard

Copy the log window contents to the Clipboard by right-clicking in the log window and select "Copy" 
from the context menu.

Clearing the log window

Clear the log window contents by right-clicking in the log window and select "Clear" from the context 
menu.

Displaying the log view

The Log command on the AbsoluteFTP View menu allows you to show or hide the session's log view.



    Long Format

Request that the FTP server include all available columns of informational output when performing 
directory listings.    This option is usually only useful when the server is a UNIX system.

This option is off by default.



    Loopback Address

The loopback address 127.0.0.1 is a special, reserved IP address that is used to refer to the local 
computer.    It is often called the localhost address.



    Manual Download

Download a specified file or folder.    This command will initiate a transfer from the FTP server to a local 
directory.    The default local directory is set to the download directory specified in the download directory 
settings of the Session     Options   or Global     Options  .    The path of the file or folder to download is entered 
manually.    This feature is often used to download a file that is intentionally hidden by the server but can 
still be retrieved if the user knows the exact name and location of the file.



    Manual Upload

Upload a specified file or folder.    This command will initiate a transfer from the local machine to the FTP 
server.

By default, the local path is set to the path of the currently selected item in the active pane of the local 
window, if any.    The remote path is set to the currently selected directory of the active remote window.

This option is only enabled when a session window is active and selected.



    Navigating a Session

Each FTP session is represented by its own session window 

The left pane of the session window shows the hierarchy of the folders on the remote host.

Click a folder in the left pane to display its sub folders and files in the right pane (If the folder 
contains any sub folders then a (+) will also appear to the left of the folder icon).

A folder-open icon 
 indicates which folder is currently selected in the left pane. The complete contents of the currently 

selected folder are shown in the right pane.

Double-click a folder icon in the left pane (or click the +/-) to expand and collapse the tree of sub 
folders in the left pane. 

A log window of FTP commands for a session can be viewed by dragging the lower border of the 
session window upward.



    New Session Wizard

The New Session Wizard guides you through the steps of adding a new session to your session 
database. The wizard prompts you for the following information that it stores in your new session:    Once 
the information is filled out on the Introductory page of the wizard, the Finish button can be clicked at 
any time.    If clicked prior to going through all pages in the wizard, the standard default values will be 
used.

Introductory page - items on the Introductory page are:

Hostname/IP Address

Optionally, select non-default Port to change the port number.

Do not use this wizard when creating a session check box.    If this option is selected, then the 
Session Options dialog will be used to gather session information rather than the wizard.

Login Page - items on the Login page are:

Anonymous login check box

Username

Password

Directories page - items on the Directories page are:

Initial Directory

Final page - items on the Final page are:

A session name that will be used to identify the session in the session database.

A description for the session that will be shown as a tool tip when you move the mouse pointer 
over the session name in the Connect dialog



    Open

Opens the currently selected file or folder.

You can also double-click a file to open it, or you can select it and choose Open from the right mouse 
button menu.

AbsoluteFTP can be configured to automatically download and open a file on a remote site with an 
associated application. The configuration options are available in the File Types page in the Global 
Options dialog.

If you open a file on a remote site and save any changes to the file, AbsoluteFTP will prompt you to 
upload the file back to the remote site as part of its remote file editing feature.



    Open URL

The Open URL dialog allows you to connect to a remote host using its Uniform Resource Locator (URL). 
This dialog can be used to connect to an FTP server and list the directory or download a file that is 
specified by a URL obtained from a Web browser or an e-mail message.

In the Open URL dialog:

1. Enter the URL (e.g., ftp://ftp.vandyke.com/pub/AbsoluteFTP).

2. Click OK.



    Open With

Opens the currently selected file using a chosen application.

This command allows you to override the "Open with" setting of the file type for the selected file.    This is 
also the default action when opening a file that has no associated file type.

If you open a file on a remote site and save any changes to the file, AbsoluteFTP will prompt you to 
upload the file back to the remote site as part of its remote file editing feature.

"Open With" is also available from the context menu.



    Feature Requests and Questions

If you think you've found a bug or a problem with AbsoluteFTP please refer to the section on reporting 
problems.

If you have a general question about AbsoluteFTP send e-mail to:

AbsoluteFTP-questions@vandyke.com

If there is a feature that you would like to see added to AbsoluteFTP, send e-mail describing the feature 
to:

AbsoluteFTP-features@vandyke.com

If you would like to receive e-mail notification of new releases, please go to:

http://www.vandyke.com/support/newreleasemailinglist.html



    PASV

Force the FTP server into passive mode when establishing data connections.    This will cause 
AbsoluteFTP to actively create any data connections rather than passively listen for data connections 
from the server.    This option is sometimes needed where the client machine resides on a network whose 
firewall will not allow incoming connections from external FTP servers.

The options for using this command can be found in both the Session Options and the Global Options.



    Port

The port number to connect to on the remote server.    The default port value for FTP is 21.    The default 
value should be sufficient for most sessions, but some servers may require that you connect to them 
using a non-default port number.



    Properties

Opens the Properties dialog on a remote file or folder.

The Properties dialog displays information such as the name, type, location, size, creation/modification 
date and owner for the selected file. Additionally, the attributes section of the dialog also allows you to 
view and change the UNIX-style permissions on files and folders.

Note:  Viewing and changing the attributes of remote files and folders is not supported by all servers. 
This feature is currently only available on UNIX-based servers.

Tip

 This toolbar button invokes the Properties command.



    Quick Connect

The Quick Connect dialog allows you to connect to a remote host that is not present in the session 
database.

The Session group displays the protocol that is being used.

The FTP group allows you to configure your FTP connection.    In this group:

1. Enter the Hostname or IP address of the remote FTP server for the session.    (This is the only 
required field.    You can click OK to make the connection).

2. Change the Port number (optional).

3. Check the Use firewall to connect option if you want this session to use the firewall configured 
in the Firewall category of the Global Options dialog.    This option is off by default when no 
firewall is configured and on by default when a firewall is configured.

Tip:    This option may be useful for mobile customers that want to configure two different 
sessions to connect to the same server (one with and one without the firewall).    One session 
can be used when at work (behind a firewall) and the other when traveling (connected directly 
to the Internet).

4. Enter a Username and Password for the remote session, or accept the default Anonymous 
Login setting.

Note:    If either the Username or Password entry boxes are left blank, then you will be 
prompted for that information when the connection is made.

The Initial directory group allows you to specify the initial directory for the session.

Checking the Save Session check box will save the settings to the session database.    The name used 
will be the hostname or IP address supplied for the session.

Click on the OK button to complete your connection.

Tip

       This toolbar button invokes the Quick Connect dialog.



    Quick Synchronize

The Quick Synchronize dialog enables you to initiate a comparison operation between a local directory 
and a directory on a remote server.    The results of the comparison are displayed in the Synchronize 
Window.

Local

Path - Enter the path of the local file or directory.    The browse button 

 to the right of this field can be used to help you find an existing local file or directory.    You may also 
use wildcard characters (i.e. * and ?) when specifying filenames.    For example, you can use '*.txt' to 
specify that you only want to compare and synchronize the local files in the chosen directory that have the 
'.txt' extension.

Remote

Session - Enter the path of the session for the remote FTP server.    You may use the browse 
button 

 to the right of this field to activate a dialog that will help you find and select the desired session.

Path - Enter the path of the directory on the remote FTP server.

Options

Direction - Choose the direction in which the synchronization is to take place.    The choices are:

- Upload - List those files that may need to be transferred from the local machine to the remote 
machine.

- Download - List those files that may need to be transferred from the remote machine to the 
local machine.

- Mirror - List both the Upload and Download files.    If you choose this option, Quick Synchronize 
will transfer files in both directions.    This takes place when a file has been removed from one side or if 
a file has a different timestamp.

Note:    Because the Quick Synchronize feature does not currently support the ability to 
delete files, none of the three Direction options treats one side as a "master" since that would 
require the "delete" operation.

Include subdirectories - Choose whether or not the comparison operation should include 
subdirectories

Click on the OK button bring up the comparison dialog and start the comparison operation.

Tip

 This toolbar button invokes the Quick Synchronize dialog.



    Quote Command

The Quote Command feature is used to send a command directly to the FTP server. Any messages 
returned by the FTP server in response to the command are displayed both in the log window and in a 
separate, pop-up window.



    Reconnect

Reestablishes the connection to the FTP server for the current session and logon using the username 
and password for that session. 

The connection to an FTP server may be dropped as the result of a timeout after a period of inactivity, or 
because the user has executed the Disconnect command. Invoking the Refresh command, opening a 
directory or transferring a file within a session that is disconnected will cause the session to automatically 
reconnect. You may, however, manually reconnect to the FTP server using this menu item.

Tip

 This toolbar button invokes the Reconnect command.



    Refresh

Updates the displayed information for the selected session by retrieving a new listing.

The folders and files present on a remote FTP server may change at any time. Refresh obtains a new 
listing for the current folder from the server.

Tip

 This toolbar button invokes the Refresh command.



    Remote File Editing

Automatically uploads a remote file that has been opened and changed on the local machine.

This feature automatically detects a change in the modified date of a remote file that has been opened in 
AbsoluteFTP.    For instance, if you Open a file on a remote site, make changes to the file in the chosen 
application, and save the changes to disk,    AbsoluteFTP will automatically prompt you to upload the file 
back to its original location on the remote site.



Automatically open the file (after downloading) using the associated program when remote files of this 
type are opened.



    Rename

Renames the currently selected file or folder.



    Reporting Problems

You may report problems or bugs to us through our on-line problem-report form on the AbsoluteFTP 
support Web page:

http://www.vandyke.com/support/absoluteftp/

You can also report problems by sending e-mail to us at the following address:

AbsoluteFTP-bugs@vandyke.com

When reporting bugs through e-mail, please try to provide the following information:

The steps needed to reproduce the bug.

A description of the problem in as much detail as possible.

The version of AbsoluteFTP (as shown in the About dialog box).

TCP/IP package and version.

The operating system and version (and Service Pack #, if any)



    Resolve Symbolic Links

Requests that the FTP server resolve symbolic links automatically when performing directory listings.    
This option is usually only useful when the server is a UNIX system.

This option is off by default.    If the server resolves symbolic links, then symbolic links to files and folders 
will be completely transparent and look no different than regular files and folders.

If this feature is disabled, symbolic links in a folder will initially be displayed with this icon:

 

Clicking on a symbolic link icon will resolve the link to the actual file or directory to which the link points.



    Resume

Resumes an interrupted file download for the current session.    AbsoluteFTP keeps track of all files and 
folders for an interrupted transfer and will transfer the remaining portion of any interrupted file as well as 
all remaining files and folders.

An interrupted transfer can be resumed at any time in a session by selecting Resume from the File 
menu.    Additionally, if a transfer has been interrupted for any session in the session database, then the 
next time that session is started a dialog will prompt with the following choices:

Resume the interrupted download immediately

Delay resuming the download until later

Forget about the interrupted download

To turn off this prompting, uncheck the "Prompt to resume interrupted transfers" option in the 
General     Global     Options   dialog.

Interrupted file transfers may also be resumed manually or on-demand in addition to the above 
mechanism.    This is accomplished by simply transferring the file in the usual way (i.e. drag-and-drop, 
cut/paste, download, etc.).    If the file already exists in the destination folder, AbsoluteFTP will compare 
the size of the source file against the size of the destination file.    If the size of the destination file is less 
than the size of the source, AbsoluteFTP will ask you if you want to overwrite the destination file, resume 
the transfer, or skip the file transfer.



Automatically open a dialog that prompts for the filename and the location to save the remote file when it 
is opened.



    Select All

Select all of the items in the current folder.



    Session Database Location

Choose the directory where the session database files (AbsoluteFTP.dat, AbsoluteFTP.idx) will be stored.

This command is not available when sessions are active.



    Session History

Connect to a session from the list of most-recently-used sessions.



    Session Window Options

Choose the mode to display session windows.

Cascade

Resize and display all open session windows to be slightly overlapped and descending from the 
upper-left corner of the main window.

Tile Horizontally

Resize and display all open session windows to be the width of the main window, equal-sized and 
vertically spaced to fill the entire main window.

Tile Vertically

Resize and display all open session windows to be the height of the main window, equal-sized and 
horizontally spaced to fill the entire main window.



    Set Initial Directory

Copy the path of the selected folder into the appropriate Initial directory configuration field.

When this option is used in a session window, the Initial directory field of the Session Options, Options 
category    will be set to the path of the currently selected folder.
When this option is used in the local window, the Local window  field of the Global Options, Options 
category will be set to the path of the currently selected folder.



    Status Bar

Shows or hides the status bar for the selected session window.

When enabled, the status bar appears at the bottom of a session window. Informational text such as 
connection status, or the number of folder entries, is displayed in the status bar.

The status bar is enabled by default. 



    Stop

Interrupts the current FTP operation in the active remote session window.

Tip

 This toolbar button stops the current operation and stops any reconnect attempts.



    Synchronize Window

The Synchronize window displays the results of a comparison operation.    It also displays the status of 
the files and directories as they are being transferred.

Display
Items in the Synchronize window are color-coded to better distinguish their differences.    The following 
color schemes are used:

Identical
Normal text colors (usually black text on a white background) are used to indicate items that exist on 
both the source and target machines, and are identical in both timestamp and size.

Different
Red text on a gray background is used to indicate an item that exists on both the source and target 
machines, but are different in either timestamp or size.

Source Only
Blue text on a gray background is used to indicate that the item exists only on the source machine.

Target Only
Green text on a gray background is used to indicate that the item exists only on the target machine.

Options
Items displayed in the synchronize window may be individually selected for action or they may be acted 
on as a whole.

Synchronize All:    This action causes all items that are different in any way to be synchronized 
(regardless of which items are currently selected).    The transfer action (i.e., upload or download) for 
each item is determined by the current status.    For example, if an item's timestamp is more recent for 
the file on the source machine, then the file will be automatically uploaded.

This option is available on the window's context menu and on the toolbar.

Upload:    This action pertains only to selected items and forces the selected items to be uploaded 
regardless of the comparison result.

This option is available on each item's context menu and on the toolbar.

Download:    This action pertains only to selected items and forces the selected items to be 
downloaded regardless of the comparison result.

This option is available on each item's context menu and on the toolbar.

Stop:    This toolbar button causes the operation in progress to halt, and brings the synchronize 
window to an idle state.

Properties:    Choosing this option displays a separate window where the individual properties (such 
as time, date, and size) of the source and target files pertaining to the selected item may be 
compared side by side.

Synchronize Source Only Items:    This action causes all items to be uploaded for which the file or 
directory resides only on the source machine.

Synchronize Source Newer Items:    This action causes all items to be uploaded for which the file on 



the source machine has a more recent timestamp.

Synchronize Target Only Items:    This action causes all items to be downloaded for which the file or 
directory resides only on the target machine.

Synchronize Target Newer Items:    This action causes all items to be downloaded for which the file 
on the target machine has a more recent timestamp.

Synchronize Different Items:    This action causes all items to be transferred for which the file 
resides on both the source and target machines but has a different timestamp or size.

Tips

 Synchronize All:    This toolbar button initiates a complete synchronize operation.

 Upload:    This toolbar button uploads the selected items (regardless of how they are marked).

 Download:    This toolbar button downloads the selected items (regardless of how they are marked).

 Stop:    This toolbar button stops the current operation in progress.

 Properties:    This toolbar button displays the attributes of the source and target items for visual 
comparison.



    System Requirements

Minimum of a 486-based machine with 16 megabytes of RAM.

Windows 98 / 95, Me, NT 4.0, 2000,    XP, or 2003

Winsock.dll (compliant with version 1.1 of the WinSock standard).

32-bit TCP/IP stack.



    Toolbar

Show or hide the toolbar.

When enabled, the toolbar appears below the AbsoluteFTP menu bar.    Move the mouse cursor over a 
toolbar button to view its associated action.    The toolbar is enabled by default.    The toolbar can be 
customized to suit the preferences and needs of the user.

Default Toolbar Icons

Icon Action

Display the Connect     dialog

Display the Quick Connect dialog

Reconnect the selected session window

Disconnect the selected session window

Copy the selected item(s)

Paste the selected item(s)

Refresh the current view

Stop the current FTP operation

Delete the selected item(s)

Open the Properties dialog for the selected item

Show/hide the folder tree

Move the view up one level from the current folder

Display files and folders as large icons

Display files and folders as small icons

Display files and folders as a list

Display files and folders in detail

Quick Synchronize

Display the AbsoluteFTP Help

Additional Toolbar Icons

Icon         Action  

Create a new folder in the current folder

Open URL.

Download

Manual download



Resume an interrupted file download 

Copy URL

Copy path

Select all in the current directory

Invert the selection in the current directory

Show/hide dot files

Display the Global Options dialog

Display the Quote Command dialog

Show/hide log view

Cascade windows

Tile windows horizontally

Tile windows vertically



    Transferring Files

Transferring files to or from FTP sites is easily accomplished by any of the following operations:

Open a remote file - Opening a file (either by double-clicking on it or by using the Open menu 
command) in a remote session window will initiate a download of the file.    By default, you will be 
prompted whether you want to open the file in its associated application or save it to disk.    You can 
configure AbsoluteFTP to automatically save the file to disk or open it by specifying the open action when 
editing or registering the file type.

You may also choose the menu Download command to initiate a transfer of the selected files 
and folders from a remote session window to a local download directory specified in the Session or 
Global Options.

You may also initiate a transfer using the Copy and Paste or Drag-and-Drop methods 
(described below)

The steps to upload a local file to a remote FTP server are as follows:

Connect to a remote FTP server.

Optionally, choose the 'Tile Horizontally' item from the 'Window' menu to size the local and remote 
windows and place them side-by-side.

In the local window, browse to and open the folder/directory that contains the files you want to 
upload.

In the remote/session window, browse to and open the folder/directory to which you want to 
upload the local files.

At this point, you can initiate the file transfer using either the "drag-and-drop" or "cut and paste" 
method.

- Drag-and-drop: using the left mouse button, click on the icon for file you want to transfer and 
continue to hold down the left mouse button.    While still holding down the left mouse button, 
move the mouse cursor so that it is positioned over the right-hand pane (where the folder 
contents are shown) of the remote window.    Release the left mouse button to "drop" the file 
on the remote window.

Or

- Cut and paste: select/highlight the files that you want to transfer.    Choose the 'Copy' item 
from the 'Edit' menu.    Then, select the folder/directory in the remote window to which you 
want to upload the files.    Then, choose the 'Paste' item from the 'Edit' menu.

A separate window should appear that shows the progress of the transfer.

When the transfer completes, the target window will automatically refresh and the transferred files should 
be visible in the right-hand pane of that window.



The copy/paste or drag-and-drop methods may also be used to initiate file and folder transfers directly 
between remote FTP servers.



Opens a dialog that lets you choose whether to automatically open the file (after downloading) with an 
associated application or save it to disk each time a remote file of this type is opened.



    Welcome

VanDyke Software's AbsoluteFTP is the easy, powerful way to transfer files using FTP, with a simple 
Explorer-like interface and advanced features like direct server-to-server transfers.    AbsoluteFTP works 
like Windows Explorer to drag and drop files between local and remote systems.    Predefined sites and a 
New Site Wizard get you started quickly. 

AbsoluteFTP provides an extensive set of advanced features for file transfer including multiple concurrent 
transfers and site synchronization.    But powerful features don't necessarily mean a steep learning curve 
AbsoluteFTP has been designed to make complex operations quick and easy.

This file documents AbsoluteFTP version 2.2.    If you do not find the information you need here, please e-
mail any questions you have to the following address:

AbsoluteFTP-questions@vandyke.com.

We will try to respond to such inquiries within one to two business days.

For the latest information about AbsoluteFTP and VanDyke Software, Inc., check out our home page:

www.vandyke.com

To receive the latest news about VanDyke Software products as well as tips and tricks, reading 
recommendations, and interesting customer stories, subscribe to our monthly newsletter at: 

http://www.vandyke.com/support/newreleasemailinglist.html?PID=2

Thank you! 

The AbsoluteFTP Product Team 



    Window Menu List

The titles of each of the local and remote windows are displayed in a list in the Window menu. The 
currently selected window is checked. Click on a window title to bring it to the top and select it.



    AbsoluteFTP License Agreement

End-User License Agreement for AbsoluteFTP 2.2 ("Software")
Copyright (c) 1995-2004 VanDyke Software, Inc.
All Rights Reserved.

AGREEMENT. After reading this agreement carefully, if you ("Customer") do not agree to all of the terms 
of this agreement, you may not use this Software. Unless you have a different license agreement signed 
by VanDyke Software, Inc. that covers this copy of the Software, your use of this Software indicates your 
acceptance of this license agreement and warranty. All updates to the Software shall be considered part 
of the Software and subject to the terms of this Agreement. Changes to this Agreement may accompany 
updates to the Software, in which case by installing such update Customer accepts the terms of the 
Agreement as changed. The Agreement is not otherwise subject to addition, amendment, modification, or 
exception unless in writing signed by an officer of both Customer and VanDyke Software, Inc.

This Software is owned by VanDyke Software, Inc. and is protected by national copyright laws and 
international copyright treaties.

1. EXPORT LAW. This Software is subject to export control. The Software may be transmitted, exported, 
or re-exported only under applicable export laws and restrictions and regulations of the United States 
Bureau of Industry and Security or foreign agencies or authorities. By downloading or using the Software, 
you are agreeing to comply with export controls. The Software may not be downloaded or otherwise 
exported or re-exported to any country subject to U.S. trade sanctions governing the Software, 
sanctioned countries including Cuba, Iran, Iraq, Libya, North Korea, Sudan and Syria, or by citizens or 
residents of such countries except citizens who are lawful permanent residents of countries not subject to 
such sanctions, or by anyone on the U.S. Treasury Department's list of Specially Designated Nationals 
and Blocked Persons or the U.S. Commerce Department's Table of Denial Orders.

2. GRANT OF LICENSE AND PROHIBITIONS. This Software is licensed to you. You are not obtaining 
title to the Software or any copyrights. You may not sublicense, rent, lease, convey, modify, translate, 
convert to another programming language, decompile, or disassemble the Software for any purpose. The 
license may be transferred to another individual (not resold) if you keep no copies of the Software. 
Permission must be obtained before mirroring or redistributing the evaluation copies of the Software.

3. USE AND EVALUATION PERIOD. You may use copies of this Software (one copy being the server 
application, the client application, or both) on the number of computers authorized in your registration 
documentation. A copy of this Software is considered in use when loaded into temporary memory (i.e., 
RAM) and/or installed on a permanent storage device (i.e., hard disk, CD-ROM, etc.). You may use an 
evaluation copy of the Software for only thirty (30) days in order to determine whether to purchase the 
Software.

4. MULTI-COMPUTER LICENSES.    If this is a multi-computer license, you may make, install, and use 
additional copies of this Software up to the number of copies authorized in your registration 
documentation. Unless you have a terminal server license agreement signed by VanDyke Software, Inc., 
use of this Software is not allowed in environments in which the Software is located on a central server 
and is accessed by multiple computers If this is an educational license, use is restricted to non-
commercial use by students, faculty and staff using campus facilities and to off-campus non-commercial 
use by students, faculty and staff primarily for school business.

5. LIMITED WARRANTY. THE SOFTWARE IS PROVIDED AS IS AND VANDYKE SOFTWARE 
DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, WHETHER EXPRESSED OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE. 

6. LIMITATION ON DAMAGES. NEITHER VANDYKE SOFTWARE NOR ANYONE INVOLVED IN THE 



CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE SHALL BE LIABLE FOR ANY 
INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF THE USE OR 
INABILITY TO USE SUCH SOFTWARE EVEN IF VANDYKE SOFTWARE HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES OR CLAIMS. IN NO EVENT SHALL VANDYKE SOFTWARE'S 
LIABILITY FOR ANY DAMAGES EXCEED THE PRICE PAID FOR THE LICENSE TO USE THE 
SOFTWARE, REGARDLESS OF THE FORM OF CLAIM. THE PERSON USING THE SOFTWARE 
BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE.

7. TERMINATION. This Agreement terminates on the date of the first occurrence of either of the following 
events: (1) The expiration of one (1) month from written notice of termination from Customer to VanDyke 
Software, Inc.; or (2) One party materially breaches any terms of this Agreement or any terms of any other 
agreement between Customer and VanDyke Software, Inc., that are either uncorrectable or that the 
breaching party fails to correct within one (1) month after written notification by the other party.

8. GOVERNING LAW. The agreement shall be governed by the laws of the State of New Mexico. Any 
action or proceeding brought by either party against the other arising out of or related to this agreement 
shall be brought only in a state or federal court of competent jurisdiction located in Bernalillo County, New 
Mexico. The parties hereby consent to the personal jurisdiction of such courts.

9. U.S. GOVERNMENT RESTRICTED RIGHTS. This Software is provided with RESTRICTED RIGHTS. 
Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph 
(a) of the Rights in Commercial Computer Software clause at DFARS 227.7202-3 or subparagraphs (c)(1) 
and (2) of the Commercial Computer Software -- Restricted Rights clause at 48 CFR 52.227-19, as 
applicable. Manufacturer is:

VanDyke Software, Inc.
4848 Tramway Ridge Dr. NE, Suite 101
Albuquerque, NM    87111      USA

E-mail: sales@vandyke.com



    Establish a Secure Connection using SSH1

The FTP protocol uses two separate channels for data transfer.    The control channel is used to transmit 
the user logon information and the FTP commands.    The data channel is used to transmit the actual file 
data.

Combined with VanDyke Software's SecureCRT®, AbsoluteFTP can encrypt the data sent on the control 
channel.    This protects the user logon information.    Files and directory listings transferred on the FTP 
data channel, however, will not be encrypted.    This combination uses the port forwarding capabilities of 
SecureCRT to encrypt the control channel.    To encrypt both channels, we recommend using VanDyke's 
SecureFX® connected to an SSH2 server.

Below is a diagram that depicts the connections between servers and which channel or connection is or is 
not encrypted.

Before setting up port forwarding for the first time, review the topic "Port Forwarding in SecureCRT" in 
SecureCRT's online help.    Also, make sure that you can successfully connect to the target FTP server 
using a normal session profile.

Note:    Firewalls and proxies are not supported in this configuration.    Also, some FTP servers do not 
support this type of connection for security reasons.

For up-to-date instruction on how to combine SecureCRT with AbsoluteFTP please refer to the following 
URL on our Web site:

http://www.vandyke.com/support/absoluteftp/faq.html

If you do not have Web access, send e-mail to AbsoluteFTP-support@vandyke.com for instructions.

SecureCRT is available for download at:

http://www.vandyke.com/download/securecrt/index.html

SecureFX is available for download at:

http://www.vandyke.com/download/securefx/index.html



    What is AbsoluteFTP?

AbsoluteFTP® is a 32-bit WinSock application that uses the File Transfer Protocol (FTP) to transfer files 
over the Internet and intranets. AbsoluteFTP has a rich set of features, including a familiar Windows 
Explorer interface, drag-and-drop file transfers, resumable interrupted transfers, customizable file types, 
and multiple simultaneous connections and transfers. Browsing your favorite FTP sites to download new 
applications, images, and other files is now easier than ever with AbsoluteFTP.

AbsoluteFTP includes a 30-day, try-before-you-buy, fully-functional evaluation license.

AbsoluteFTP is ideal for browsing your favorite FTP sites. Many software and hardware companies use 
FTP sites (ftp.vandyke.com, ftp.netscape.com, ftp.microsoft.com) to distribute their software. There are 
also many FTP sites that specialize in distributing games, images and applications for all types of 
operating systems.

AbsoluteFTP has the following set of features:

Familiar Windows® Explorer look and feel

Upload and download multiple files from multiple sites concurrently

Direct server-to-server transfers

Resume interrupted/incomplete file transfers

URL support

Firewall support (including SOCKS versions 4 and 5, as well as TIS, WinGate, WinProxy and 
CSM, proxy support)

Hierarchical session database for managing personal sites

Named sessions allow saving of individual preferences for each site

Automated download action by file type

Manual download for downloading hidden files

Drag-and-drop (and copy and paste) file transfers

Network Neighborhood support

Ability to change file attributes

Easy setup/install

Automatic resolution of symbolic links (option)

Auto hide of dot files (option)

Quote command

Uppercase/lowercase filename conversion on upload

Quick Connect dialog for easy connections

Common features accessible via the right mouse button menu

Easy access to AbsoluteFTP features through graphical toolbar



Remote host directory listings are cached



    AbsoluteFTP Order Form

Upon receipt of payment, we will send you one license key for 
each copy of AbsoluteFTP paid for.  The license key or keys will 
be sent to you by e-mail or postal mail. All software and 
software updates are available from www.vandyke.com.  Because 
the software is obtained by Internet download, no disk media 
will be mailed.

Individual licenses for AbsoluteFTP are $29.95 (U.S.).  Four 
payment methods are available.

  1. Order online with a credit card.

     To order online using a secure web server, go to:

       http://www.vandyke.com/order/index.html

  2. Order by mail with a check.

     To order by mail, send this order form and a check to:

       VanDyke Software
       4848 Tramway Ridge Dr. NE, Suite 101
       Albuquerque, NM  87111
       USA

     Payment must be in U.S. dollars drawn on a U.S. bank. 

  3. Order by phone with a credit card.

     To order by phone, call VanDyke Software between 7:30 a.m. 
     and 5:00 p.m. U.S. Mountain Time, Monday through Friday. 

       Phone:  505-332-5710

  4. Order by fax with a credit card.

     You can fax the order form below to VanDyke Software.  Please
     be sure to fill out the credit card information.

       Fax:    505-332-5701

Visa, MasterCard, American Express, and Discover are accepted.
Please include the credit card number, cardholder name, 
expiration date, and billing address.

Orders will be processed within one to two business days after
they are received by VanDyke Software.  Most online orders are 
processed in 15 minutes or less.



Please direct any questions about order shipment status, refunds, 
registration options, product details, technical support, volume 
discounts, reseller pricing, site licenses, or non-credit card 
orders to sales@vandyke.com, or write to VanDyke Software, Inc., 
4848 Tramway Ridge Dr. NE, Suite 101, Albuquerque, NM 87111, USA.

                               ----

The pricing below is valid through March 31, 2004. After this
date, please check http://www.vandyke.com for current pricing.

                               ----

                    AbsoluteFTP 2.2 Order Form
                    --------------------------

  Single Computer License                      $29.95 each = ______

  2 to   9 Computers: ____ Computer Licenses @ $27.50 each = ______

 10 to  24 Computers: ____ Computer Licenses @ $25.00 each = ______

 25 to  49 Computers: ____ Computer Licenses @ $20.00 each = ______

 50 to  99 Computers: ____ Computer Licenses @ $17.50 each = ______

Quantities over 99, please send email to:  sales@vandyke.com

New Mexico Residents ONLY: add 5.8125% sales tax         + ________

                                      Total Payment        ________

 - Payments must be in U.S. dollars drawn on a U.S. bank.
 - The above prices are for any mix of Windows 2003, XP, 2000,
   NT, Me, 98, or 95.
 - Prices are based on the number of computers on which the 
   software is installed.
 - Prices are in U.S. dollars.

                     --- Please Print ---

Name: _____________________________________ Date: _________________

Company: __________________________________________________________

Address: __________________________________________________________

City, State, Zip: _________________________________________________

Country: ______________________ Phone Number: _____________________

E-Mail Address: ___________________________________________________

Would you like to receive update announcements by e-mail? _________

How did you hear about AbsoluteFTP? _______________________________



Comments: _________________________________________________________

          _________________________________________________________

Credit Card Orders Only:

Name On Credit Card: ______________________________________________

Credit Card Number: _______________________________________________

Expiration Date: __________________________________________________

Credit Card Billing Address: ______________________________________

___________________________________________________________________

Signature: ________________________________________________________

VanDyke Software and AbsoluteFTP are trademarks of VanDyke Software, 
Inc. in the United States and other countries.



    Global Options, Options

The following options control attributes of transfers and FTP connections.

Local directories

Local window - Enter the path of a local directory that the local window should display on 
startup.    Click on the 

 browser button to use a directory browser to select the directory.

Download directory - Enter the path of a local directory that is to be used as the destination 
folder when the Download command is used and the download directory in the Session     Options   is left 
blank.    Click on the 

 browser button to use a directory browser to select the directory.

Cache directory - Choose the directory where AbsoluteFTP will place its temporary files.    Click 
on the 

 browser button to use a directory browser to select the directory.

Anonymous login

Password - Enter the anonymous password (usually an e-mail address) that you want to use as 
the default when you are creating anonymous login sessions.    Note that if you do not fill in this field, 
AbsoluteFTP will attempt to fill in anonymous password fields with a password of the form: username@.

Directory tree options

Disable directory tree detection - This option is unchecked by default.    It sets the default 
behavior for the identical Session Options option.    Checking this option will disable the directory tree for 
the current session.

Transfer options

Verify file status on retrieve - This option is checked by default.    It causes a LIST command to 
be sent prior to retrieving a file from the FTP server in order to obtain the most current statistics (i.e., size 
and date) for the file.



    Global Options, General

The following options control attributes of transfers and FTP connections.

Transfer options

Default transfer type - Choose the default file transfer type for undefined file types.

- ASCII - Select this mode to transfer text files.
- Binary - Select this mode to transfer program files, or other non-text files such as ZIP files.
- Prompt for type - Select this option if you want to be prompted for the transfer type each 

time a file of the selected type is downloaded.

Action for existing files - Choose the default overwrite action when files in a target directory 
already exist. the choices are:

- Confirm overwrite - presents a dialog confirming whether or not to overwrite files. The 
confirmation dialog allows you to confirm overwrites individually, or to choose the action for all 
files in the transfer with "Yes to All" or "No to All".

- Always overwrite - always overwrites existing files in the destination directory.
- Never overwrite - never overwrites existing files in the destination directory.
- Overwrite if older - overwrite existing files whose timestamp is older than the source file.

Preferences

Prompt to resume interrupted transfer - Select whether or not to be prompted to resume 
interrupted transfers when starting a session.    If this option is not selected, AbsoluteFTP will not attempt 
to resume interrupted transfers at startup.    This option is enabled by default.

Prompt to disconnect on close - Choose if you want to be prompted about closing connections 
when you close session windows. This option is enabled by default.

Close window on disconnect - Choose whether or not to close session windows when a 
session is disconnected. This option is disabled by default.

Restore last session directory - Choose if you want to restore the last remote directory that was 
visited when starting a session. This option is disabled by default.

Connection retry options
This group contains options that allow you to create a retry strategy. 

Maximum number of attempts - Choose the maximum number of logon retry attempts that will 
be performed after a failed logon attempts.

Delay between attempts - Choose the number of seconds to delay between retry attempts.

Remote edit options
This group contains options that allow you to define actions to be taken after editing a file.



When the editor exits - Choose the action to be taken when the editor exits after a file has been 
modified.

- Prompt - asks the user to enter an action.
- Always upload - always uploads the edited file in the destination directory.
- Never upload - never uploads a file whether or not it has been modified..

Upload when the file is saved in the editor - Check this box to execute the action selected 
above when a file has been modified and saved.    AbsoluteFTP determines when to take action by 
checking the timestamp on the file being edited to see if the file has been modified before the editor exits. 
If the file has been modified, AbsoluteFTP implements the action defined by the above option.

Note:    If you are using an editor, such as MS Word, that locks files while they are open, 
AbsoluteFTP cannot upload the updated file while the editor is running.    You will need to close 
the file or exit the editor before the file can be uploaded.



    File Transfer Type

Choose the default file transfer type for undefined file types.

ASCII - Select this mode to transfer text files.

Binary - Select this mode to transfer program files, or other non-text files such as ZIP files.

Prompt for type - Select this option if you want to be prompted for the transfer type each time a 
file of the selected type is downloaded.



    Global Options, Options / FTP

The following options control attributes of FTP transfers.

Receive and Send buffers

By default the system default buffer sizes are used. It is highly recommended that you use the 
system default buffer sizes.

Data connection options

Use outgoing data connections (PASV) - This option is on by default.    This is used as the 
default setting for the identical Session Options option.

Disable direct server-to-server transfers - This option is unchecked by default.    Checking this 
option will force all server-to-server transfers to be handled by establishing indirect data connections 
through the local host.    This option is sometimes needed where a server behaves poorly after receiving a 
request to establish a server-to-server connection.



    Session Options, Site

The following options control attributes of an FTP session and the FTP connection.

Session

Name - Enter the name of the session.    This is the name that will be displayed in the Connect 
dialog

Protocol - Select the connection protocol to be used with this session.    The available protocols 
are:

- FTP - cause the connection to be made using the normal FTP protocol.

FTP login

This group only appears when FTP is selected as the Protocol.

Hostname or IP - Enter the hostname or IP address of the FTP server to which you want to 
connect

Port - Enter the port number for the FTP server.    The default FTP port is 21. 

Use firewall to connect - Check this option if you want this session to use the firewall configured 
in the Firewall category of the Global Options dialog. 

Tip:    This option may be useful for mobile customers that want to configure two different 
sessions to connect to the same server (one with and one without the firewall).    One session 
can be used when at work (behind a firewall) and the other when traveling (connected directly 
to the Internet).

Anonymous login - When the Anonymous login option is selected , AbsoluteFTP automatically 
selects anonymous as the username and fills in the password field using the password you supplied in 
the Global     Options   dialog.    Unselecting this option makes the username and password fields available.

Username - Enter your username on the remote host. 

Password - Enter your password. 

AbsoluteFTP supports standard one-time password challenges and can generate responses using MD4 
and MD5.    It currently does not support S/Key and OPIE challenge formats.    If the FTP server issues a 
one-time password challenge, AbsoluteFTP will automatically calculate the required response using your 
password, prompting for it if necessary.

Account - Enter an account name.    This parameter is usually not needed (optional).



    Session Options, Site / Description

Enter an optional description for the session. Later, when you move the mouse pointer over    the name of 
a session in the Connect dialog, this description will appear in a tool tip. (optional).



    Session Options, Options

The following options control attributes of the directory locations for a given session.

Local directories

Local window - Enter the path of a local directory that the local window should display on startup 
of the session.    Click on the 

 browser button to use a directory browser to select the directory.

Download directory - Enter the path of a local directory that is to be used as the destination 
folder when the Download command is used.    Click on the 

 browser button to use a directory browser to select the directory.

Remote directories

Initial directory - Enter the full path of a directory on the remote hose.    That directory will be 
made the current directory upon connection to the remote host.

Directory tree options

Disable directory tree detection - This option is unchecked by default.    Checking this option 
will disable the directory tree for the current session.    When this check box is unchecked, AbsoluteFTP 
will leave the directory tree enabled. 

This check box can also be set to a third, indeterminate state.    When the check box is in this state, it 
appears grayed out and will cause AbsoluteFTP to use the setting in the identical, Global Options option.

Transfer options

Verify file status on retrieve - This option is checked by default.    It causes a LIST command to 
be sent prior to retrieving a file from the FTP server in order to obtain the most current statistics (i.e., size 
and date) for the file.

This check box can also be set to a third, indeterminate state.    When the check box is in this state, it 
appears grayed out and will cause AbsoluteFTP to use the setting in the identical, Global Options option.



    Session Options, Options / FTP

The following options control attributes of FTP connections.

Data connection options

Use outgoing data connection (PASV) - setting    the Use outgoing data connections (PASV) 
check box to force all data connections to be originated by AbsoluteFTP (using the FTP PASV command). 
This setting is often needed where a firewall will not allow incoming connections from external FTP 
servers.    When this check box is unchecked, AbsoluteFTP will have the FTP server create an incoming 
data connection instead (using the FTP PORT command).

This check box can also be set to a third, indeterminate state.    When the check box is in this state, it 
appears grayed out and will cause AbsoluteFTP to use the setting in the identical, Global Options option.

Directory listing options

Resolve symbolic links - setting the Resolve symbolic links option to cause AbsoluteFTP to 
include the '-L' flag when listing files and directories.

Long Format - setting the Long format option to cause AbsoluteFTP to include the '-l' flag when 
listing files and directories.

All entries - setting the All entries option to cause AbsoluteFTP to include the '-a' flag when 
listing files and directories.



    Session Options, Options / Advanced

The following options control server and upload attributes for a given session.

Server parameters

Operating System - Select the operating system used on the FTP server.    By default, this option 
is set to automatically detect the operating system on the FTP server when connecting.    This option 
allows you to override the automatic detection and specify a supported type.

Time zone - Select the time zone of the FTP server.    This information is used when translating 
file times from the FTP server so that a more accurate comparison can be performed when comparing 
local file time and remote file times.

By default, this option is set to automatically detect the time zone of the server, if possible, using the 
server's connection reply.    Many servers put time and date information in the initial reply text sent from 
the server, and AbsoluteFTP will attempt to determine time zone of the server from this text.    If it fails to 
detect an appropriate time zone, the local time zone (i.e. the time zone in use on the client machine) is 
used by default.

Upload options

Filename conversion - Choose the filename conversion rule that will be applied to uploaded 
files.    The choices for this option are as follows:

- Preserve case: this option will cause AbsoluteFTP to create the file on the remote machine 
using the filename exactly as it is stored on the local machine.

- Uppercase: this option causes the alphabetic characters in a filename to be converted to all 
uppercase.

- Lowercase: this option causes the alphabetic characters in a filename to be converted to all 
lowercase.

File creation mask - Enter a File creation mask (also called the UMASK) that will be used when 
a new file is uploaded to the FTP server.    By default, this option is blank, which means that the UMASK 
command will not be sent to the FTP server, and the server will use the default UMASK setting for current 
logon.



    New Folder

Select this option to create a new folder. 

When selected, AbsoluteFTP will prompt for the name of the new folder.    Enter the name and click on 
OK.    The new folder will be created as a sub-folder of the currently selected folder.



    Username

Username:    If you did not enter a username on the Session Options, Site page, you will be prompted 
for it when you attempt to connect.    Enter your remote account username in the space provided.

Save username: If you wish AbsoluteFTP to save your username, select this check box.    By saving it,    
you will not be prompted the next time you connect to this session.



    Password

Password    If you did not enter a password on the Session Options, Site page, you will be prompted for 
it when you attempt to connect.    Enter your remote account password in the space provided.

Save password If you wish    AbsoluteFTP to save your password, select this check box.    By saving it, 
you will not be prompted the next time you connect to this session.



    Log

Allows you to show or hide the session's log view.

This option corresponds to the Display the log view option in the Global Options. 



    Arranging Entries in the Connect Dialog

By default, AbsoluteFTP maintains the list of entries in the Connect dialog in alphabetical order.    The list 
of entries in the Connect dialog are automatically arranged in alphabetical order by AbsoluteFTP as long 
as the User Arranged Tree option is disabled.

Enabling the User Arranged Tree option allows the user to manually arrange the entries in the Connect 
dialog.    With the User Arranged Tree option enabled, the user can easily resort the list by moving 
individual sessions or even entire folders using a drag-and-drop operation, and can copy items using a 
CTRL+drag-and-drop operation.

Enabling/Disabling User Arranged Tree

To enable/disable the User Arranged Tree option in AbsoluteFTP, complete the following steps:

1. Right-click on any entry listed in the Connect dialog to open the dialog's pop-up menu.

2. If User Arranged Tree is currently enabled, the User Arranged Tree menu item in the pop-up 
menu will have a check mark next to it.    To enable/disable this option, select User Arranged 
Tree from the pop-up menu.    If User Arranged Tree was previously enabled, it will now be 
disabled and the entry in the pop-up menu will not have a check mark next to it.    If User 
Arranged Tree was previously disabled, it will now be enabled and the entry in the pop-up menu 
will have a check mark next to it.



    Folder Tree

This command allows you to to display or hide the folder tree view.    This command temporarily 
supersedes the default setting in the Global Options.    This behavior is the same as that of the Folder 
Tree toolbar button.



    Enter Proxy Username

Username:    If you did not enter a username on the Global Options Firewall page, you will be prompted 
for it when you attempt to connect.    Enter your remote account username in the space provided.

Save username: If you wish AbsoluteFTP to save your username, select this check box.    By saving it,    
you will not be prompted the next time you connect to this session.



    Enter Proxy Password

Server prompt    This field displays the prompt string returned from the server    allowing you to see 
challenge codes, if applicable for the server.

Password    If you did not enter a password on the Global Options Firewall page, you will be prompted 
for it when you attempt to connect.    Enter your remote account password or challenge code (as 
applicable) in the space provided.

Save password    If you wish    AbsoluteFTP to save your password, select this check box.    By saving it, 
you will not be prompted the next time you connect to this session.



    Enter License Data Wizard

You are currently in the AbsoluteFTP Enter License Data wizard, which will step you through the process 
of entering your registration information.    This information should be on the Software Registration 
Information letter that your received from VanDyke Software when you purchased AbsoluteFTP.

If you have not purchased AbsoluteFTP, How to Order Licenses will show you how.

You should have your Software Registration Information letter handy as you go through the Enter License 
Data wizard to ensure that you enter all the information correctly.    The wizard will ask you for your Name, 
Company, License Key, Serial Number, and Expiration Date.    You must enter this information exactly as it 
appears on your Software Registration Information letter.



    Copyright and Trademarks

AbsoluteFTP® 2.2 Documentation Copyright © 1995-2004 VanDyke Software, Inc.    All Rights Reserved.

AbsoluteFTP is a trademark of VanDyke Software, Inc.

SSH2 is a trademarks of SSH Communications Security Oyj in the United States and/or other countries.

Windows and Windows NT are registered trademarks of Microsoft Corporation in the United States and/or 
other countries.



    Command-Line Utility

The AFTPCL command-line utility allows you to perform tasks from the command line.    The utility 
recognizes general command-line instructions (which all use a similar syntax) as well as the additional 
QuickSync option that requires a specific syntax.

General Command-Line Instructions

General command-line instructions use the following syntax:

AFTPCL [Option] Source [Source] [Source...] Destination

Source parameters may be either a file or folder, and can contain wildcard characters.    In other words, 
an asterisk (*) may be used to represent zero or more characters, or a question mark (?) may be used to 
represent a single character.

The table below lists the general command-line options recognized by AFTPCL with their applicable 
arguments.    An asterisk denotes default actions.

Option Argument Description

/DefaultType prompt If a file does not have a defined file type, this will 
prompt you for the transfer type that you want to 
use.

acsii If a file does not have a defined file type, this will 
transfer the file in ASCII.

binary * If a file does not have a defined file type, this will 
transfer the file in binary.

/Log path/filename Turns on logging for the AFTPCL session and 
writes to the specified file.

/NoPrompt Causes AFTPCL to dismiss all user input 
prompts as though the user clicked on the 
Cancel button or pressed the ESC key.    In most 
cases (e.g., username and password prompts), 
using this option will cause AFTPCL to exit with 
an error.

/Overwrite prompt If a destination file already exists, this will prompt 
you to overwrite the file or not.

always * If a destination file already exists, this will always 
overwrite the file.

never If a destination file already exists, this will never 
overwrite the file.

older If a destination file already exists, this will 
overwrite the file if it is older than the source.

/Q Keeps AFTPCL from sending its output to the 
screen.



The table below lists the source and destination parameters recognized by AFTPCL with their applicable 
arguments.

Source / 
Destination

Argument Description

URL Transfers files to or from the specified URL.    
FTP URLs must be in the following format:

ftp://[<user>[:<password>]@]<host 
address>[:<port>][<path>]

Hostname Transfers files to the specified host or IP 
address

/S session path Transfers files to or from the specific session. 

The session path must be the full path of a 
session profile in the database as in the 
following example:

"/Software/Commercial 
Software/VanDyke Software"

If the pathname contains spaces, enclose it in 
quotation marks.

Note: The root folder "FTP Sites" cannot be 
included in the path to a session when using the 
command line utility.    Use a "/" instead.

Examples of General Command-Line Instructions

Transferring a file from the Policies folder of the Headquarters session to the Presentation folder on a 
local drive and renaming the file.

AFTPCL.exe /S /Headquarters /Policies/Mission.txt "c:\My 
Documents\Presentation.txt"

Transferring all files from two remote source folders to one local destination folder:

AFTPCL.exe /S /Ops /Bob/Payroll.txt /S /Ops /Alice/Memo.txt "c:\My 
Documents"

Transferring local files to a session folder with a prompt to overwrite if the files already exists.

AFTPCL.exe /Overwrite prompt c:\Memo1.txt d:\Memo2.txt /S /Headquarters 
"/The Boss/Memos/"

Transferring Word and Excel (.doc and .xls) files from a local documents folders to a remote host.

AFTPCL.exe "c:\My Documents\*.doc" "c:\My Documents\*.xls" 
ftp://ftp.mysite.com/users/bob/documents



Logging all transfer activity for a given week to the same file (where %week% is an environment variable 
set by another tool) 

AFTPCL.exe /Log c:\Weekly Logs\%week%.log ftp://host/pub/*.log c:\June1to7

Logging all transfer activity for a given command-line QuickSync target (where Target is an environment 
variable set in your batch file).

Set Target=Corporate
AFTPCL.exe /Log "c:\Transfer Logs\%Target%.log" /QuickSync C:\
%Target%Data\*.* /%Target% C:\Data Mirror
Set Target=Sales
AFTPCL.exe /Log "c:\Transfer Logs\%Target%.log" /QuickSync C:\
%Target%Data\*.* /%Target% C:\Data Upload

Other Command-Line Operations

/QuickSync

This operation initiates a comparison operation between a local folder and a folder on a remote server, 
and transfers files according to the argument specified.

The /QuickSync operation must be entered on the command line with the following syntax:

AFTPCL.exe /QuickSync <local path> <session path> <remote path><upload | 
download | mirror>

For example, to mirror a local folder with a remote folder:

AFTPCL.exe /QuickSync "c:\My Documents" "/SSH2Session" /Users/Bob/Docs 
mirror

/Delete

This operation deletes the specified files or directories.    Deleting local files is not allowed

The /Delete operation cannot be combined with other file operations on the same command line.    If this 
operation is specified, all remote items listed on the command line will be deleted unconditionally.

Multiple remote items may be specified on a single command, and the items specified may contain 
wildcard characters.

The syntax for the /Delete operation is as follows:

AFTPCL.exe [options] /Delete remotesource [remotesource [...]]

/Rename

This operation renames files or directories from the command line. 

The syntax for the /Rename operation is a follows



AFTPCL.exe /rename remotesource [remotesource [...]] newname

Returned Values

After AFTPCL completes a run, it returns a value to the initiating entity (application, batch file, etc.).    If the 
run was successful, the program will return a zero (0).    If the run had any errors, AFTPCL will return 
something other than zero.    This returned value can then be used by other applications.    For example, 
see the following batch file.

AFTPCL /quicksync C:\MyDocuments MySession /pub/docs download
if not errorlevel 0 goto fail
if errorlevel 0 goto success

See also:

Command-Line Usage



    Glossary

client
A computer or application that uses services provided by a server.

connection
A data path or circuit between two computers over a phone line, network cable, or other media.

Related topics: 
Connect
Toolbar

disconnect
To close a communication connection between a client and a server.

Related topics:
Disconnect
Toolbar

FTP
FTP is an abbreviation for the File Transfer Protocol; a protocol used to transfer files between 
computers on a TCP/IP network.

server
A computer program that provides services to other computer programs (called clients).    Often the 
computer on which a server program runs is also called a server.    The term host is often used as a 
synonym for server.

session
A session is a set of options that are assigned to a connection to a remote machine in AbsoluteFTP.    
These settings and options are saved under a session name and allow the user to have different 
preferences for different hosts.

Related topics:
Session Options, Site
Session Options, Options

session name
The label assigned to a session.    For example, a user might use "Accounting DB" as a session name 
for a session that connects to sales.mycompany.com.

Related topics:
Session Options, Site

TCP/IP
Transmission Control Protocol/Internet Protocol:    TCP/IP is the basic communication method used 
over the Internet.    The TCP on the side of the sending machine is responsible for breaking up a 
message in to smaller portions called packets.    These packets are then sent to their destination and 
the TCP on the side of the receiving machine is responsible for reassembling the packets to form the 
original message.    The Internet Protocol provides a means of properly addressing each packet so 
that it arrives at its destination.    SSH and FTP, for example, are built upon TCP/IP.





    Retry Strategy

A retry strategy consists of how many times AbsoluteFTP will try to reinitiate a connection after it has 
been lost, and how long AbsoluteFTP will wait between those attempts.

By default, AbsoluteFTP will try to reconnect 20 times, waiting 10 seconds between each attempt.    
However, it does take AbsoluteFTP up to three minutes to realize that a connection has been lost before it 
begins retrying the connection.    This means that if you are transferring five files and the network drops 
the connection on the second file, three minutes later AbsoluteFTP will attempt to reconnect.    If it fails 
(leaving 19 retry attempts), it will wait 10 seconds and try again (and so on).    If it is able to reconnect 
within the 20 retry attempts, AbsoluteFTP will restart the transfer with the second file and the retry attempt 
count is reset to 20.    Any other disruption in the connection will cause AbsoluteFTP to begin the retry 
strategy again.

You can also specify the retry attempts and retry delay from the command line using the following 
command strings. 

/RetryCount <count>        where the variable count can be replaced by either an integer value 
or by the word infinite (if you would like to configure "relentless retries").

/RetryDelay <seconds>        where the variable seconds is replaced by an integer value.

See also:

Global Options, General



    Extend Most Recently Used List

Near the bottom of the AbsoluteFTP File menu is a list of the most recently used sessions.    By default 
this list contains the last four sessions that were used, but you can change the number of displayed 
sessions by editing the following registry entry: 

HKEY_CURRENT_USER\Software\VanDyke\SecureFX\Global\Maximum Recent File List 
Count

This entry can be set from zero (0) to nine (9).    If you set the registry entry to 0, the list will not be 
displayed.



    New in AbsoluteFTP

AbsoluteFTP® 2.2 introduces improved remote editing by allowing the file being edited to be uploaded to 
the remote server each time the file is saved on the local machine.    With multiple-file transfer support, an 
interrupted file transfer is resumed along with any other files in a job.    This feature is not supported for 
server-to-server transfers.

The 2.2 release also includes the ability to change permissions on multiple files and copy individual lines 
of text from the log window to the clipboard.




